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Trademarks and Legal Notices 
 
©2019 Satori Publishing. All Rights Reserved. 
 
Satori Publishing 
P.O. Box 8566 
Michigan City, Indiana 46361-8566 
U.S.A. 
http://www.satoripublishing.com 
 
Lotto Sorcerer’s Apprentice™ is a trademark of Satori Publishing. Lotto Sorcerer’s Apprentice is also protected by 
international copyrights (©2019 Satori Publishing). All Rights Reserved. 
 
All trademarks are the property of their respective owners. 
 
Except where noted, screenshots in this manual are from the Mac OS X Snow Leopard (10.6) version of Lotto Sor-
cerer’s Apprentice. The appearance of the screens from other operating systems will be reasonably similar to the 
views displayed here. 
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Conventions Used in this User’s Guide 
 

Menu Se l e c t i on  
Menus are referred to by using a greater-than symbol (“>”) between menu elements. For example, “Lottery Data > 
Lottery Data Subscription > Start Subscription” means to choose the main menu item “Lottery Data”, then, from 
the menu that appears, choose “Lottery Data Subscription”, and then, from the submenu that appears, choose 
“Start Subscription”, as shown in Figure 1. 

 

 
Figure 1. 

Tab Se l e c t i on  
Tab selection is referred to in the same fashion as menu selection. For example, “Main Window > Parameters” 
means to choose the “Parameters” tab in the Main Window. 

El l i p s e s  i n  Menu I t ems  
An ellipsis (…) at the end of a menu item indicates that an application needs additional user input to execute the 
item's command. 

The “Ma in  Window” 
The “Main Window” refers to the primary window used by Lotto Sorcerer’s Apprentice. The majority of activity 
takes place within this window, and closing this window terminates the program. Figure 2 shows screenshot of the 
Main Window: 
 

 
Figure 2. 
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Lotto Sorcerer’s Apprentice End User License Agreement 
 
This “End User License Agreement” (“Agreement”), dated February 19, 2019, supersedes all prior Agreements. Un-
der this Agreement, Satori Publishing (the “Vendor”) grants to the user (the “Licensee”) a non-exclusive and non-
transferable license (“License”) to use Lotto Sorcerer’s Apprentice (the “Software”). 
 
The English version of this Agreement supersedes all non-English versions, parts and parcels of the Agreement. 
 
The Software includes the executable computer programs and any related printed, electronic and online documen-
tation and any other files that may accompany the product. 
 
Title, copyright, intellectual property rights and distribution rights of the Software remain exclusively with the 
Vendor. Intellectual property rights include the look and feel of the Software. This Agreement constitutes a license 
for use only and is not in any way a transfer of ownership rights to the Software. 
 
The rights and obligations of this Agreement are personal rights granted to the Licensee only. The Licensee may 
not transfer or assign any of the rights or obligations granted under this Agreement to any other person or legal 
entity. The Licensee may not make available the Software for use by one or more third parties. 
 
Failure to comply with any of the terms of this Agreement will be considered a material breach of this Agreement. 

Pa r t  I :  You r  Agr e emen t  t o  th i s  L i c en s e  
The Licensee should carefully and completely read this License before downloading, installing, using, distributing 
the Software, and before purchasing the registration fee for the Software. Unless you have a different license 
agreement signed by the Vendor, your use, distribution, or installation of the Software indicates your acceptance of 
the License. If agreement to this License is in violation of local, regional, national or international laws, you are 
prohibited from downloading, installing or using the Software. Your installation, use or purchase of the registration 
fee of the Software signifies your agreement to this License. 

Pa r t  I I :  Eva l u a t i on  Ve r s i on  Spe c i f i c s  
The terms and conditions of Part I, Part II and Part IV of this License describe the permitted use(s) of each Evalua-
tion Copy of the Software. 

Scope of License 
This is not free software. Subject to the terms below, you are hereby licensed by the Vendor to use one copy of the 
Software, on one (1) computer or workstation, for evaluation purposes without charge for a period of 12 uses. If you 
use this software after the 12-use evaluation period a registration fee is required. For current pricing, see the Ven-
dor’s web site at http://www.satoripublishing.com/LSA/ or write Satori Publishing, P.O. Box 8566, Michigan City, 
IN 46361-8566, USA. Payments via check must be in US dollars drawn on a US bank. Payments via money order 
must be made using a United States Postal Service money order or an international money order, and must be in 
US dollars. Checks and money orders should be sent to Satori Publishing, P.O. Box 8566, Michigan City, IN 46361-
8566, USA. 
 
See the Vendor’s web site at http://www.satoripublishing.com/LSA/ for information about secure online ordering. 
Online ordering is processed through PayPal, and can be transacted in other currencies besides US dollars. 
 
Unregistered use of the Software after the 12-use evaluation period is in violation of U.S. and international copy-
right laws, including, but not limited to, the Digital Millennium Copyright Act of the United States. 
 
You may, without making any payment to the Vendor: 

http://www.satoripublishing.com/LSA/
http://www.satoripublishing.com/LSA/
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a) give exact copies of this evaluation version of the Software personally to anyone, except for the purpose of 
extending their 12-use evaluation period; 
b) distribute exact copies of this evaluation version of the Software, if done exclusively through electronic 
channels; and 
c) make as many exact copies of this evaluation version of the Software as you wish, for purposes of distribu-
tion as described in (a) and (b) above. 

 
You are not prohibited from charging, or requesting donations, for any copies of the evaluation version, however 
made, and from distributing such copies with other products of any kind, commercial or otherwise. However, the 
Vendor reserves the right to revoke the above distribution rights at any time, for any or no reason. 

Pa r t  I I I :  L i c en s e d  (Reg i s t e r e d )  Ve r s i on  Spe c i f i c s  
The terms and conditions of Part I, Part III and Part IV of this License describe the permitted use and user(s) of 
each Licensed (Registered) Copy of the Software. 
 
For purposes of this License, if you have a valid single-copy license, you have the right to use a single “Licensed 
Copy” of the Software on one user account on one computer. 
 
You agree to allow Lotto Sorcerer’s Apprentice to transmit from time to time, via TCP/IP, information required to 
validate your registration code. 

License Fee 
The original purchase price paid by the Licensee will constitute the entire license fee and is the full consideration 
for this Agreement. 

Scope of License 
Each Licensed Copy of the Software may be used only by a single person on one user account on one computer. If 
there are multiple users on the computer or workstation, each user must have a separate license. This is not a con-
current use license. This is a “named-seats” license. 

Pa r t  IV :  Gene r a l  Te rms  and  Cond i t i on s  
The terms and conditions of Part IV of this License describe the permitted use of each Evaluation and/or Licensed 
(Registered) Copy of the Software. 
 
All rights of any kind in the Software which are not expressly granted in this License are entirely and exclusively 
reserved to and by the Vendor.  
 
You may not rent, lease, modify, translate, reverse engineer, decompile, disassemble, or create derivative works 
based on, the Software, nor permit anyone else to do so. Attempts to circumvent the registration process (including, 
but not limited to: counterfeiting the registration codes to the Software; using fraudulent means to acquire the reg-
istration codes to the Software) is software piracy and is a violation of international law, the Copyright Law and the 
Digital Millennium Copyright Act of 1998. Detected violations and the discovery will be reported to the appropri-
ate law enforcement authorities; the violator will be subject to court costs, seizure of any property used in the act of 
the piracy, statutory and/or punitive damages to the Vendor of US$100,000 per infringed copy, plus fines of 
US$250,000 and/or prison terms for up to six years. 
 
You may not make access to the Software available to others in connection with a service bureau, application ser-
vice provider, or similar business, nor permit anyone else to do so. 

Warranty Disclaimers and Liability Limitations 
THE SOFTWARE, AND ANY AND ALL ACCOMPANYING SOFTWARE, FILES, DATA AND MATERI-
ALS, ARE DISTRIBUTED AND PROVIDED “AS IS” AND WITH NO WARRANTIES OF ANY KIND, 
WHETHER EXPRESS OR IMPLIED. YOU ACKNOWLEDGE THAT GOOD DATA PROCESSING PRO-
CEDURE DICTATES THAT ANY PROGRAM, INCLUDING THE SOFTWARE, MUST BE THOROUGHLY 
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TESTED WITH NON-CRITICAL DATA BEFORE YOU RELY ON IT, AND YOU HEREBY ASSUME THE 
ENTIRE RISK OF USING THE PROGRAM. THIS DISCLAIMER OF WARRANTY CONSTITUTES AN ES-
SENTIAL PART OF THIS LICENSE. 
 
THE VENDOR WILL NOT BE LIABLE FOR ANY GENERAL, SPECIAL, INCIDENTAL OR CONSE-
QUENTIAL DAMAGES INCLUDING, BUT NOT LIMITED TO, LOSS OF PRODUCTION, LOSS OF 
PROFITS, LOSS OF REVENUE, LOSS OF DATA, OR ANY OTHER BUSINESS OR ECONOMIC DISAD-
VANTAGE SUFFERED BY THE LICENSEE ARISING OUT OF THE USE OR FAILURE TO USE THE 
SOFTWARE. 
 
THE VENDOR DOES NOT WARRANT THAT USE OF THE SOFTWARE WILL BE UNINTERRUPTED 
OR ERROR-FREE. THE LICENSEE ACCEPTS THAT SOFTWARE IN GENERAL IS PRONE TO ERRORS 
AND FLAWS WITHIN AN ACCEPTABLE LEVEL AS DETERMINED IN THE INDUSTRY. 
 
SOME STATES OR OTHER JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR LIMITATION OF 
LIABILITY FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE SOFTWARE IS PROHIBIT-
ED FROM BEING INSTALLED, PURCHASED, USED OR DISTRIBUTED IN THOSE STATES OR JURIS-
DICTIONS. 
 
Historical lottery data included with the Software is included as a customer courtesy only. Although the Vendor 
endeavors in good faith to make this data complete and accurate, absolutely no warranty is implied as to its com-
pleteness and/or accuracy. 
 
The word “guarantee”, used in the Software, only has mathematical meaning and implies no legal liability. 
 
Additionally, no refunds will be given after purchase of the Software. You must utilize the evaluation period to 
decide if the Software meets your needs and is compatible with your systems. 
 
The absolute maximum liability of the Vendor will be limited exclusively to purchase price. In addition, in no 
event shall the Vendor, or its principals, owners, officers, employees, affiliates, contractors, subsidiaries, or parent 
organizations, be liable for any indirect, incidental, consequential, or punitive damages whatsoever relating to the 
use of the Software, or to your relationship with the Vendor. 
 
In addition, in no event does the Vendor authorize you or anyone else to use the Software in applications or sys-
tems where the Software’s failure to perform can reasonably be expected to result in a significant physical injury, or 
in loss of life. Any such use is entirely at your own risk, and you agree to hold the Vendor harmless from any and 
all claims or losses relating to such unauthorized use. 

Warrants and Representations 
The Vendor warrants and represents that it is the sole copyright holder of the Software. The Vendor warrants and 
represents that granting the license to use this Software is not in violation of any other agreement, copyright or ap-
plicable statute. 

Acceptance 
All terms, conditions and obligations of this Agreement will be deemed to be accepted by the Licensee ("Ac-
ceptance") on installation of the Software. 

User Support 
No user support or maintenance is provided as part of this Agreement. 

Lottery Data Subscription Service 
THE “LOTTERY DATA SUBSCRIPTION SERVICE” IS AN OPTIONAL ADD-ON SERVICE PROVIDED 
BY THE VENDOR, AND IS NOT INCLUDED WITH THE PURCHASE OF THE REGISTRATION FEE OF 
THE SOFTWARE. 
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Term 
The term of this Agreement will begin on Acceptance and is perpetual. 

Termination 
This Agreement will be terminated and the License forfeited where the Licensee has failed to comply with any of 
the terms of this Agreement or is in breach of this Agreement. On termination of this Agreement for any reason, the 
Licensee will promptly destroy the Software or return the Software to the Vendor. 

Force Majeure 
The Vendor will be free of liability to the Licensee where the Vendor is prevented from executing its obligations 
under this Agreement in whole or in part due to Force Majeure, such as earthquake, typhoon, flood, fire, and war 
or any other unforeseen and uncontrollable event, natural or man-made, where the Vendor has taken any and all 
appropriate action to mitigate such an event. 

Miscellaneous 
This Agreement can only be modified in writing signed by both the Vendor and the Licensee. 
 
This Agreement does not create or imply any relationship in agency or partnership between the Vendor and the 
Licensee. 
 
Headings are inserted for the convenience of the parties only and are not to be considered when interpreting this 
Agreement. Words in the singular mean and include the plural and vice versa. Words in the masculine gender in-
clude the feminine gender and vice versa. Words in the neuter gender include the masculine gender and the femi-
nine gender and vice versa. 
 
If any term, covenant, condition or provision of this Agreement is held by a court of competent jurisdiction to be 
invalid, void or unenforceable, it is the parties' intent that such provision be reduced in scope by the court only to 
the extent deemed necessary by that court to render the provision reasonable and enforceable and the remainder 
of the provisions of this Agreement will in no way be affected, impaired or invalidated as a result. 
 
This Agreement contains the entire agreement between the parties. All understandings have been included in this 
Agreement. Representations which may have been made by any party to this Agreement may in some way be in-
consistent with this final written Agreement. All such statements are declared to be of no value in this Agreement. 
Only the written terms of this Agreement will bind the parties. 
 
This Agreement and the terms and conditions contained in this Agreement apply to and are binding upon the 
Vendor's successors and assigns. 
 
This License is the complete statement of the agreement between the parties on the subject matter, and merges and 
supersedes all other or prior understandings, purchase orders, agreements and arrangements. This License shall be 
governed by the laws of the State of Indiana, without regard to Indiana choice-of-law rules. Exclusive jurisdiction 
and venue for all matters relating to this License shall be in courts and fora located in the State of Indiana, county 
of La Porte, and you consent to such jurisdiction and venue. There are no third party beneficiaries of any promises, 
obligations or representations made by the Vendor herein. Any waiver by the Vendor of any violation of this Li-
cense by you shall not constitute, nor contribute to, a waiver by the Vendor of any other or future violation of the 
same provision, or any other provision, of this License. This software is not to be used where the Software or any 
term of this License is void or prohibited by law. 
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System Requirements 
 

Windows  
• Intel or AMD Athlon processor 
• Windows XP, Windows Vista, Windows 7, Windows 8 (and 8.1), Windows 10 

Mac OS X 
• Intel Macintosh (10.4 [“Tiger”] to 10.11 [“El Capitan”]) 
• PowerPC Macintosh (10.4 [“Tiger”] to 10.5 [“Leopard”]) 

macOS 
• Intel Macintosh (10.12 [“Sierra”] to 10.14 [“Mojave”]) 
•  
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Basic Operations 
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Quick Tutorial 

 
Figure 3. 

 
Using Lotto Sorcerer’s Apprentice is an easy process, with just three steps: 
 

1. Setup at least one lottery. 
2. Enter numbers previously drawn (manually, through importing or online updating). 
3. Have Lotto Sorcerer’s Apprentice generate suggested numbers to play. 

St ep  One o f  Th r e e  

 Setup a lottery 
You need to setup at least one lottery. Choose the menu item “Lottery Structure > Lottery Setup Wizard”. 
 
For more information on this subject, see Lottery Setup Wizard (page 23). 

St ep  Two o f  Th r e e  

 Bring the Lottery Drawing History Up-to-date 
You will need to bring the lottery's database up-to-date with prior drawings so that Lotto Sorcerer’s Apprentice 
can calculate a meaningful analysis and extrapolate recommended numbers to play. There are three ways to do this: 

1. Entering Prior Draws via: 
a. Manual entry (page 16) 
b. Web scraping (page 56) 

2. Updating by using the optional Lottery Data Subscription Service (page 35) 
3. Importing past draws (page 31) 

St ep  Thr e e  o f  Th r e e  

 Have Lotto Sorcerer’s Apprentice Generate Suggestions to Play 
After you have entered a sufficient number of previous drawings into the database, you can have Lotto Sorcerer’s 
Apprentice recommend numbers to play for the next upcoming drawing. To do this, from the Main Window, click 
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on the Parameters tab in the Main Window to set the parameters; then click the "Start" button in the Suggestions 
tab. 
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Main Window 

 
Figure 4. 

Overv i ew 
This is the primary window which is used in day-to-day operations within Lotto Sorcerer’s Apprentice. 

How to  Invoke  
The Main Window appears when Lotto Sorcerer’s Apprentice is started, and closing the Main Window exits (quits) 
the program. If the Main Window is obscured by another window you can select it from Lotto Sorcerer’s Appren-
tice’s “Window” menu. 

Bas i c  P ro c e du r e  
1. Select the lottery you want to work with in the “Select Lottery” dropdown menu. 
2. Enter the numbers drawn previously by using the “Drawing History” tab (or if you are a subscriber to  

the optional Lottery Data Subscription Service, click the “Update” button). 
3. Use the Parameters tab to set generation options. 
4. Use the Suggestions tab to generate suggestions 

Window Con t ro l s  
Select Lottery dropdown menu 
Use this dropdown to select a lottery (that you have previously setup). If your lottery does not appear in this 
dropdown menu, set it up by using the Lottery Setup Wizard (page 23). 
 

Drawing History tab 
This tab is for entering, editing and deleting prior drawings into Lotto Sorcerer’s Apprentice's database. For de-
tailed information on this tab, see Drawing History Tab (page 16). 
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Parameters tab 
The Parameters tab is used for selecting the analysis settings. For more information on this tab, see Parameters 
(page 18). 

Suggestions tab 
Use this tab to have Lotto Sorcerer’s Apprentice analyze the data and suggest numbers to play. For more infor-
mation on this tab, see Suggestions (page 20). 

Analysis tab 
The Analysis tab is used for viewing the suggestion analysis See page 21 for more information. 
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Drawing History Tab 

 
Figure 5. 

Overv i ew 
This is the leftmost tab in the Main Window, and is used for entering, updating, editing or deleting the numbers 
that have been drawn in the lottery. 

How to  Invoke  
After selecting a lottery from the “Select Lottery” dropdown, click the “Drawing History” tab in the Main Window. 

Bas i c  P ro c e du r e  (Manua l  Da t a  En t r y )  
1. Select the date of the drawing by entering the drawing date in the “Date of Drawing” control. Enter the 

date in YYYY-MM-DD (four digit year, two digit month and two digit day) format. 
2. Enter the numbers drawn in the Numbers Drawn text fields. 
3. Click the “Enter” button to enter it into the database. 

Bas i c  P ro c e du r e  (Ed i t i n g )  
You can also use this window for editing numbers that you have entered in error. To do this, just find the line in 
the grid at the top of the window that contains the data you want to correct, and click anywhere on its row; the 
data will appear in the bottom part of the window. Correct the data, then click the “Enter” button, or you can de-
lete the entire drawing data by clicking the “Delete” button. 
 

Bas i c  P ro c e du r e  (On l i n e  Upda t i n g )  
Click the Update button in the Main Window. When doing so, Lotto Sorcerer’s Apprentice will go online, and 
download the latest drawings for the selected lottery. 
 
Online updating is only available for users who are subscribers to our optional Lotto Data Subscription Service, 
and for supported lotteries that were setup from the list of built-in lotteries in the Lottery Setup Wizard. For a list 
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of current supported lotteries, use Lotto Sorcerer’s Apprentice’s menu item “Lottery Data > Lottery Data Subscrip-
tion > Show Supported Lotteries”. 

Bas i c  P ro c e du r e  (Web Sc r a p i n g )  
If your lottery displays its drawings results online via a web page, you may be able to “scrape” this data into Lotto 
Sorcerer’s Apprentice. For details, please see page 56. 

Window Con t ro l s  
Lottery grid 
Located at the top of the window, this spreadsheet-style grid shows all of the numbers that you have entered for 
this lottery. Drawings are shown with the newest drawings at the top of the grid. 

Date of Drawing field 
Use this field shows the date of the drawing, whether you are entering a new drawing or editing an existing one. 
Enter the date in YYYY-MM-DD (four digit year, two digit month and two digit day) format. 

Numbers Drawn fields 
These are the numbered text boxes near the lower right part of the window. This is where you enter (or edit) past 
drawing numbers. Tip: for numbers less than ten, precede each number with a zero (for example, enter “7” as “07”), 
so that the text cursor automatically moves to the next field. 

Clear button 
Click this button to clear the buttons in the “Numbers Drawn” text boxes. 

Update button 
If you are a subscriber to our optional Lottery Data Subscription Service, clicking this button will update your lot-
tery. Please note that only supported built-in lotteries (that you selected with the Lottery Setup Wizard) can be up-
dated in this fashion. If this button is not visible, then the lottery you are currently working with is not eligible for 
online updating. 
 
Once updating is complete, this button becomes ghosted. 

Delete button 
Click this button to delete a record that already exists in the database. If it is ghosted, that is because you have not 
selected a record from the Lottery grid yet. Find the record in the grid, at the top of the window, and click on the 
row. The “Delete” button will become enabled. 

Enter button 
Click this to enter the data that you have typed into the database. You should then see it appear in the grid at the 
top of the window. If this button is disabled, that means that you have not filled out the date or all of the numbers 
drawn for that drawing. 

Scrape button 
This button lets you "scrape" a web page with drawing data to paste into the Numbers Drawn boxes. Here is the 
specific procedure: 

1. In the web page with the data you want to enter, click and drag through the data you want to enter. 
2. With the data highlighted, copy the text data to your system clipboard. You can usually find this in 

your web browser's "Edit" menu. 
3. In Lotto Sorcerer’s Apprentice, click the Scrape button. 

 
This will parse the data you selected and copied, and enter it into your Numbers Drawn boxes. Please note that 
note that this will not work with all web pages. Only experimentation will show whether this works with a specific 
web page. For more information, please see page 56. 
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Parameters Tab 

 
Figure 6. 

Overv i ew 
This is the second tab in the Main window, and is used for setting the Parameters used for the analysis. 

How to  Invoke  
Click the “Parameters” tab in the Main Window. 

Bas i c  P ro c e du r e  
1. Select the desired Pool Divisor by using the “Pool Divisor” dropdown menu. 
2. If your lottery has a bonus ball, choose the “Bonus Pool Divisor” you want to use. 
3. Select the Sigma Size by clicking on the appropriate radio button in the Sigma Size group box. 
4. Choose the Analysis Strength by using the Analysis Strength slider. 
5. Select the number of lottery selections you want in the “Generate” dropdown menu. 

Window Con t ro l s  
Pool Divisor dropdown menu 
This setting selects how Lotto Sorcerer’s Apprentice divides up the number pool for generating suggestions. The 
choices presented will vary with different lotteries, because of the different parameters of different lotteries. 

Bonus Pool Divisor dropdown menu 
This setting selects how Lotto Sorcerer’s Apprentice divides up the bonus number pool for generating suggestions. 
The choices presented will vary with different lotteries, because of the different parameters of different lotteries. 
 
☞ This control will not be visible when a standard lottery is selected. 

Sigma Size radio buttons 
This control sets how Lotto Sorcerer’s Apprentice analyzes past drawings.  
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Analysis Strength slider 
Use this slider to select how much of the lottery drawing history that Lotto Sorcerer’s Apprentice will analyze. 
Generally, the larger the analysis strength, the more accurate the suggestions become, because Lotto Sorcerer’s Ap-
prentice will look deeper into the drawing history. 
If this control is set to 100%, then the entire drawing history is analyzed; if it is set to less than 100%, then the most 
recent drawing history is analyzed. 
 
☞ The evaluation version is limited to a maximum analysis strength of 10% of the drawing history. The registered 
version of Lotto Sorcerer's Apprentice does not have this limitation. 

Number of Suggestions dropdown menu 
This dropdown menu lets you choose how many suggestions that Lotto Sorcerer's Apprentice will generate. The 
number of suggestions available will change by the Pool Divisor setting… the higher the pool divisor selected, the 
less suggestions are available. 

Save button 
This button saves the parameter settings for that particular lottery. Note that “Number of Suggestions” will not be 
saved. 

Revert button 
This button restores the parameter settings to the last saved settings. 

Default button 
This button restores the parameter settings to the factory default settings. 

Choos i n g  Pa r ame t e r  Se t t i n g s  S t r a t e gy  
You have several different parameter settings to choose from. We recommend that you experiment with the differ-
ent settings, and see which one produces the best results for you. You can do this by generating a large number of 
suggestions for each parameter combination, and see how many winners each combination produced when the 
drawing is held. The parameter combination with the most wins would be the best combination to choose from. 
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Suggestions Tab 

 
Figure 7. 

Overv i ew 
This is the third tab in the Main window, and is used for generating and viewing or printing the Suggestions results. 

How to  Invoke  
Click the “Suggestions” tab in the Main Window. 

Bas i c  P ro c e du r e  
• Click the Start button 

Window Con t ro l s  
Start button 
This button starts the generation process. 

Print button 
This button allows you to print the suggestions. 

Copy button 
This copies the suggestions to the System Clipboard. 

Save button 
Clicking this button invokes a standard file dialog box, allowing you to save the suggestions to a text file. 
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Analysis Tab 

 
Figure 8. 

Overv i ew 
This is the fourth and last tab in the Main window, and is used for displaying an analysis of the generated sugges-
tions. 

How to  Invoke  
Click the “Analysis” tab in the Main Window. 

Window Con t ro l s  
Analysis text box 
This box holds the contents of the analysis, and is populated when the generation process is complete. 

Copy button 
This copies the analysis to the System Clipboard. 

Save button 
Use this for saving the analysis to a text file. 
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Lottery Structure 



Lotto Sorcerer’s Apprentice User’s Guide 
 

 - Page 23 - 

Lottery Setup Wizard 

 
Figure 9. 

Overv i ew 
This is used to setup a lottery in Lotto Sorcerer’s Apprentice. Lotto Sorcerer’s Apprentice comes with 300+ preset 
lotteries. If you can find the lottery you want to setup, and the settings are current and accurate, you can quickly set 
it up with only two mouse clicks. You can also “override” the settings if your lottery has changed. Or you can setup 
a new lottery which isn't on the list. 

How to  Invoke  
Use the menu item “Lottery Structure > Lottery Setup Wizard”. 

Bas i c  P ro c e du r e  
1. Find the lottery you want to setup from the “Locale” and “Lottery” dropdown menu, or... 
2. Create your own lottery. You will be taken through several pages, asking you questions about your lot-

tery 
3. Click the “Create” button to create the lottery 

Note s  
On the Summary page of this window, you will be shown the settings of the lottery you are setting up. Carefully 
review these settings, even if you set this lottery up as a preset, since the lottery could have made changes to the 
lottery's parameters. If any changes need to be made, just keep hitting the “Back” button until you have reached the 
page where the settings need to be changed. 
 
If you can find your lottery in dropdown menu on the first page, it is strongly recommended that you use the 
“built-in” lottery. Only built-in lotteries are eligible for the optional online updating service (“Lottery Data Sub-
scription Service”). Please note that you are limited to 32 “built-in” lotteries at any one time. There is no limit to the 
number of “custom” lotteries you can have. 
 
The “Refresh” button will go online and automatically download any new or updated lottery setup settings that 
have been added or changed since the latest release of Lotto Sorcerer’s Apprentice. 
 
☞ Please note that Lotto Sorcerer’s Apprentice can only handle “lotto-type” lotteries and lotteries with one bo-
nus ball. It does not support “all-or-nothing” type lotteries, “pick-type” lotteries, keno-type lotteries, lotteries with 
two or more bonus balls or lotteries which draw more numbers than the player can choose. 
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Edit Lottery Settings 

 
Figure 10. 

Overv i ew 
This lets you edit some of the settings for a lottery you have already setup in Lotto Sorcerer’s Apprentice. 

How to  Invoke  
Use the menu item “Lottery Structure > Edit Lottery Settings”. 

Bas i c  P ro c e du r e  
1. Select the lottery that you want to edit in the “Select Lottery” dropdown menu 
2. Change the name of the lottery, if desired 
3. Make any required changes to the pool sizes 
4. Select the days of week that the drawings of the lottery occurs 
5. Click the “Make Changes” button 

Window Con t ro l s  
Select Lottery dropdown 
Use this dropdown to select the lottery that you want to edit. 

Rename Lottery text box 
If you want to change the name of the lottery, enter the new name here. You are limited to 50 characters. 

Number Pool dropdown menus 
Use these dropdown menus to change the pool sizes for the lottery. 

Unchangeable Settings box 
This box lists settings of the lottery that cannot be changed. If these settings need to be changed, then the entire 
statistics of the lottery has been changed; so you must set it up as a separate, different lottery. 

Days of Drawings check boxes 
Select the days of the week for which this lottery has drawings. 
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Make Changes button 
Click this to make changes to this lottery. 

Cancel button 
Use this to close the current window and return to the Main window without making changes. 



Lotto Sorcerer’s Apprentice User’s Guide 
 

 -Page 26 - 

Delete Lottery 

 
Figure 11. 

Overv i ew 
This lets you delete a lottery from the Lotto Sorcerer’s Apprentice database. 

How to  Invoke  
Use the menu item “Lottery Structure > Delete Lottery”. 

Bas i c  P ro c e du r e  
1. Select the lottery that you want to delete in the “Select Lottery” dropdown menu 
2. Click the “Delete” button 

Window Con t ro l s  
Select Lottery dropdown 
Use this dropdown to select the lottery that you want to delete. 

Delete button 
Click this button to delete this lottery from the database. 

Cancel button 
Use this to close the current window and return to the Main window without deleting any lotteries. 

  



Lotto Sorcerer’s Apprentice User’s Guide 
 

 - Page 27 - 

Lottery Data 
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Clear Lottery 

 
Figure 12. 

Overv i ew 
This function will delete all drawings from the current selected lottery. Note that this function cannot be undone. 

How to  Invoke  
Use the menu item “Lottery Data > Clear Lottery”. 

Bas i c  P ro c e du r e  
1. Choose the lottery you want to clear in the “Select Lottery” dropdown menu 
2. Click the “OK” button to clear the lottery 

Window Con t ro l s  
Select Lottery dropdown menu 
Use this dropdown to select the lottery that you want to clear. 

Clear button 
Click this to clear the data from the lottery’s table. 

Cancel button 
This button will close the window without clearing any data. 
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Prune Lottery 

 
Figure 13. 

Overv i ew 
This function will delete older drawings from the current selected lottery. Note that this function cannot be un-
done. 
 

How to  Invoke  
Use the menu item “Lottery Data > Prune Lottery”. 

Bas i c  P ro c e du r e  
1. Select the lottery you want prune 
2. Select the range of data you want to delete 
3. Click the Prune button to begin the process 

Window Con t ro l s  
Select Lottery dropdown menu 
Use this dropdown to select the lottery that you want to prune. 

Before/after/between dropdown menu 
Use this dropdown to select whether you want to delete records before, after or between the selected date(s). 

Select Cutoff Date control(s) 
Select the cutoff date. Be sure to enter the date in YYYY-MM-DD (year-month-day) format. 

Prune button 
Click this to start the pruning process 

Cancel button 
This button will close the window. 
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Purge Lottery 

 
Figure 14. 

Overv i ew 
This function will delete older drawings from the current selected lottery where the drawings exceed the current 
parameters for that lottery. For example, if a lottery changed its drawing matrix from “1 to 59” to “1 to 55”, this func-
tion will delete any drawings which contain numbers higher than what is allowed. 

How to  Invoke  
Use the menu item “Lottery Data > Purge Lottery”. 

Bas i c  P ro c e du r e  
1. Select the lottery you want purge 
2. Click the Purge button to purge the lottery 

Window Con t ro l s  
Select Lottery dropdown 
Use this dropdown to select the lottery that you want to purge. 

Purge button 
Click this to start the purging process. 

Cancel button 
This button will close the window. 
 
  



Lotto Sorcerer’s Apprentice User’s Guide 
 

 - Page 31 - 

Import Delimited Text File 

 
Figure 15. 

Overv i ew 
This function lets you enter data from delimited text files directly into Lotto Sorcerer’s Apprentice. “Delimited text 
files” are files where the data fields are separated by a specific character, such as a tab or comma. Note that this 
expects the data to have the drawing date first, then the numbers drawn. If it is a bonus ball type lottery, it expects 
the final number(s) to be the bonus ball(s). 
 
The function can import a wide of different types of import files. But the import file must perfectly match the im-
port parameters you specify in order for this to work properly. 
 

How to  Invoke  
Use the menu item “Lottery Data > Import Delimited Text File”. 

Bas i c  P ro c e du r e  
1. Set the input parameters of the delimited text file 
2. Select the input file 
3. Click the “Import” button 

Window Con t ro l s  
Select Lottery dropdown 
Use this dropdown to select the lottery that you want to import data to. 

Date Format dropdown 
This allows you to select how the drawing date format. 
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Character between Date Elements dropdown 
This allows you to select the character that is between the date elements (month, day and year). The default is the 
slash (”/”). 

Character between Date and Numbers dropdowns 
This allows you to select the character that is between the date and the first of the numbers drawn. The default is 
the tab character. 

Character between Numbers dropdown 
This allows you to select the character that is between the individual numbers drawn. The default is the dash (“-”). 

Ignore first line check box 
Some delimited text files use the first line to describe the field layout. If your input file has this, check this box. 

Expected Input Format box 
Based on your previous selections, this box shows, using dummy data, how it expects the input file to look. Note 
that the tab character is represented as “[tab]”. 

Select Input File button 
Clicking this button brings up a standard file selector. Choose the file you want to import. 

Actual Input Format box 
Based on the file you selected, this box shows an actual preview of the first few lines of that file. It is important that 
this box closely resembles what is in the “Expected Input Format” box. 

Import button 
Clicking this button imports the file you have chosen into Lotto Sorcerer’s Apprentice's database. 

Cancel button 
Use this to close the current window and return to the Main window.   



Lotto Sorcerer’s Apprentice User’s Guide 
 

 - Page 33 - 

Purchase Lottery Data for Importing 
 

Overv i ew 
This function takes you (if you have an internet connection) to our webpage where you can purchase datasets of 
prior lottery drawings. Although many lotteries allow you to download prior drawings for free, we add value to this 
data by making it easy to import into Lotto Sorcerer’s Apprentice. 

How to  Invoke  
Use the menu item “Lottery Data > Import Lottery Data > Purchase Lottery Data for Importing”. 

Bas i c  P ro c e du r e  
US Datamines (http://usdatamines.satoripublishing.com) will email the lottery datasets to you. Upon receipt of the-
se files, the basic procedure is:  

1. Save the attachments to your hard drive 
2. Use Lotto Sorcerer’s Apprentice's menu item Lottery Data > Import Delimited Text File 
3. Make sure the settings in the Import Delimited Text File match the import file 
4. Choose the import file (you saved in step 1) by clicking the “Select Import File” button in the Import 

Delimited Text File window 
5. Click the Import button 

 
For details on using the Import Delimited Text File window, see Import Delimited Text File (page 31).  
 
  

http://usdatamines.satoripublishing.com/
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Subscriptions 
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Subscription Overview 
 
If you setup a built-in lottery using the Lottery Setup Wizard, you may be able to keep your lottery database up-to-
date with minimal (or even no) effort on your part by using our optional Lottery Database Subscription Service. 

Requ i r emen t s  f o r  On l i n e  Upda t i n g  
• You must have an active subscription 
• You must have unencumbered Internet access 
• You must have an active PayPal account 

How to  Sub s c r i b e  
Use menu item “Lottery Data > Lottery Data Subscription > Start Subscription”. You will be taken to a website to 
sign up. New subscribers are eligible for a free, two-week trial subscription, so you can try it to make sure that it 
works. You can cancel anytime, and if you cancel before the two-week trial period is up, you will not be charged. 
Subscription costs are only a few dollars per month.  

How to  Canc e l  You r  Sub s c r i p t i on  
Just log into your PayPal account, find the original transaction where you signed up, and click the “Cancel” button.  

How i t  Work s  
When you click the “Update Data” button in the “Drawing History” tab of the Main Window, Lotto Sorcerer’s Ap-
prentice will download data for the lottery you are working with, from the date of the last drawing in your current 
database up to the last drawing we have on our servers.  

Note 
The only lotteries that can be set up are most of Lotto Sorcerer’s Apprentice's built-in lotteries. These are the lotter-
ies listed in the dropdown menu of the first page of the Lottery Setup Wizard. 
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Cancelling a Subscription 
 
In order to cancel your subscription, you will need to: 

1. Login to your PayPal account. 
2. Find the transaction where you signed up for the subscription (you should be able to find this in the His-

tory tab on PayPal). 
3. Click the Cancel button. 

Note 
It is important that you find the transaction where you signed up, not where you made a payment towards the sub-
scription. If you do the latter, you will not see a “Cancel” button. However, there will be a link on that webpage to 
the original subscription.  
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Check Network Status 
 

 
Figure 16. 

Overv i ew 
This lets you do a quick check of the remote network status. 

How to  Invoke  
Use the menu item “Lottery Data > Lottery Data Subscription > Check Network Status...” 

Bas i c  P ro c e du r e  
• Click the “Check” button 

Window Con t ro l s  
Check button 
Click this button to check the network status. 

Cancel button 
Use this to close the current window. 
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Check Subscription Status 
 

 
Figure 17. 

Overv i ew 
This lets you check the subscription status for the optional Lottery Data Subscription Service. Once you click the 
“Check” button, your subscription status will show in this window, as well at the serial number to which this sub-
scription is tied. 
 
There are four states to your Lottery Data Subscription Status: 
 NEVER SUBSCRIBED 
 ACTIVE 
 CANCELLED - subscription will still work until it switches over to "EXPIRED" at the end of the term. 
 EXPIRED 

How to  Invoke  
Use the menu item “Lottery Data > Lottery Data Subscription > Check Subscription Status...” 

Bas i c  P ro c e du r e  
• Click the “Check” button 

  

Window Con t ro l s  
Check button 
Click this button to check the subscription status. 

Cancel button 
Use this to close the current window. 
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Get Subscription ID 
 

 
Figure 18. 

Overv i ew 
If you are a subscriber to the optional Lottery Data Subscription Service, this function lets you retrieved the Sub-
scription ID that is tied to your installation of Lotto Sorcerer’s Apprentice. 

How to  Invoke  
Use the menu item “Lottery Data > Lottery Data Subscription > Get Subscription ID...” 

Bas i c  P ro c e du r e  
• Click the “Get” button 

Window Con t ro l s  
Get button 
Click this button to retrieve the Subscription ID. 

Copy button 
If the Subscription ID is found, you can copy it to the System Clipboard by clicking this button. 
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Subscription Troubleshooter 
 
This is an online utility, which will help to quickly track down issues you may be having in using the Lottery Data 
Subscription Service. 

How to  Invoke  
To go to the Subscription Troubleshooter, use menu item “Lottery Data > Lottery Data Subscription > Subscrip-
tion Troubleshooter”. 
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Utilities 
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Backup Database 
 

Overv i ew 
This function will backup the current database into a text file. You can restore your database by using the menu 
item “Utilities > Restore Database”. It is strongly recommend that you backup your database frequently. Note that 
you are responsible for moving the file created by this function to a location specified by your organization's Disas-
ter Recovery Policy.  

How to  Invoke  
Use the menu item “Utilities > Backup Database”.  

Bas i c  P ro c e du r e  
A file selector will appear; choose the location where you want the backup file saved. The default location is in the 
folder “Backup Files”, located in the “Lotto Sorcerer’s Apprentice Files folder”, which, in turn, is located in your 
Documents folder. 
  



Lotto Sorcerer’s Apprentice User’s Guide 
 

 - Page 43 - 

Copy Database to Desktop 
 

Overv i ew 
This places a copy of your Lotto Sorcerer’s Apprentice database onto your Desktop. 
 
If you ever need to contact the Lotto Sorcerer’s Apprentice support team because of an issue with Lotto Sorcerer’s 
Apprentice, they will often request that you email them a copy of your database (so that they can duplicate the is-
sue). Some users have difficulty locating this database. By using this function, the database is copied to your Desk-
top, so that you can easily find it. 
 
☞ The original database is still in its location; only a copy is placed on your Desktop. 
 
No personal information is in the database. Only your lottery settings, structure and lottery data (past drawings). 
You can find this by using any SQLite database viewer. 

How to  Invoke  
Use the menu item “Utilities > Copy Database to Desktop”.  
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Force Database Rebuild 
 

Overv i ew 
This is an emergency function in the event that Lotto Sorcerer’s Apprentice’s internal database has become cor-
rupted (usually due to a hard disk hardware fault).  

How to  Invoke  
Use the menu item “Utilities > Database Repair Tools > Force Database Rebuild”.  

Important! 
Please note that this function does not rebuild data on the database; it re-creates a new, blank database.  
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Rebuild Lottery Definitions 
 

Overv i ew 
This function will reset the lottery definitions table to the factory defaults. 

How to  Invoke  
Use the menu item “Utilities > Database Repair Tools > Rebuild Lottery Definitions…”. 
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SQL Command Line Interface 

 
Figure 19. 

Overv i ew 
Important! This function is intended only for power users who know SQL (Structured Query Language). Because 
you have full control over the database using this interface, it is easy to inadvertently corrupt the database. You 
cannot “undo” any action. 
 
Lotto Sorcerer’s Apprentice's SQL database is a SQLite database; see the SQLite web site (at www.sqlite.org) for 
full information and syntax. This database is an ACID-compliant embedded relational database management sys-
tem adhering to most of SQL-92 standards. 

Note 
Only one command or query can be entered at one time. After the command or query is executed, the Execute 
button will become ghosted. Clicking the Clear button will clear the command box and re-enable the Execute but-
ton. 

How to  Invoke  
Use the menu item “Utilities > SQL Command Line Interface”. 

Bas i c  P ro c e du r e  
1. Enter the SQL command or query in the command box 
2. Click the “Execute” button 

Window Con t ro l s  
Clear button 
This clears the command box. 

Copy button 
This copies the contents of the command box into the System Clipboard. 

Paste button 
This pastes the System Clipboard into the command box. 

Execute button 
This will execute the SQL command or SQL query that is shown in the command box. 
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Restore Database 
 

Overv i ew 
This function will restore the database from the text file created from the “Backup Database” function. 

How to  Invoke  
Use the menu item “Utilities > Restore Database”.  

Bas i c  P ro c e du r e  
A file selector will appear; choose the file that was created by the “Backup Database” function (see page 42). 
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Backup “Lotto Sorcerer’s Apprentice Files” Folder 

 
Figure 20. 

Overv i ew 
This function backs up your entire “Lotto Sorcerer’s Apprentice Files” folder to your Desktop. This essential folder 
is located in your Documents folder. By default, Lotto Sorcerer’s Apprentice stores several important files in this 
location, including your lottery drawing database, modified and added wheels, suggestions, logs and so on. 
 
Keep in mind this is only a copy… the original folder remains in your Documents folder. 
 
If you ever need to restore this folder, simply quit Lotto Sorcerer’s Apprentice and copy this folder back to your 
Documents folder. 

How to  Invoke  
Use the menu item “Utilities > Backup ‘Lotto Sorcerer’s Apprentice Files Folder’”. 

Bas i c  P ro c e du r e  
1. Click the Start button. 

Window Con t ro l s  
Start Button 
Click this button to start the backup process. When finished, the backup folder will be located on your Desktop. 

Cancel Button 
Click this to cancel and close the window. 
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Registration 
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Registration Overview 
 
Lotto Sorcerer’s Apprentice is distributed as trial software, which, basically means you get to try the software, for 
free, for 12 uses. After the 12 uses, the software becomes disabled. If you like it and want to continue to use it, you 
must register it. 
 
To register Lotto Sorcerer’s Apprentice you will need to purchase the license for Lotto Sorcerer’s Apprentice from 
Satori Publishing. Purchasing details and current pricing can be found on Lotto Sorcerer’s Apprentice's website 
(http://www.satoripublishing.com/LSA/). 
 
When you have paid for a license, Satori Publishing will send you a name and registration code. Entering these 
items into the appropriate places in the Enter Registration Code window, then click the “OK” button. 
 
If you entered all of the information correctly, the evaluation version will be transformed into the full, registered 
version. 

http://www.satoripublishing.com/LSA/
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Enter Registration Code 

 
Figure 21. 

Overv i ew 
This is the window you use to enter your name and registration code (provided to you by Satori Publishing). 
 
If you entered all of the information correctly, the evaluation version will be transformed into the full, registered 
version. 

How to  Invoke  
Use the menu item “File > Registration > Enter Registration Code”. 

Bas i c  P ro c e du r e  
1. Enter your name in the “Name” box 
2. Enter your registration code in the “Registration Code” box 
3. Click the “OK” button 

Window Con t ro l s  
OK button 
Click this after entering your registration information. If you entered everything correctly, your evaluation version 
of Lotto Sorcerer’s Apprentice will be transformed into the full, registered version. 

Cancel button 
Click this button to close the window. 

Purchase Codes button 
Clicking this button will take you to the Lotto Sorcerer’s Apprentice website (if you have an active Internet con-
nection).  

Note 
The serial number of your copy of Lotto Sorcerer’s Apprentice is fixed, and cannot be changed manually. Rein-
stalling your operating system can cause the serial number to change. In this case, if your copy of Lotto Sorcerer’s 
Apprentice is registered, you will need to have your old registration code retired and a replacement registration 
code generated. This can be accomplished by visiting this webpage:  
 

http://www.satoripublishing.com/LSA/regcode_replace.php 

http://www.satoripublishing.com/LSA/regcode_replace.php
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Registration Troubleshooting 

 
If, after entering your codes, Lotto Sorcerer’s Apprentice tells you your codes are invalid, try these steps: 
 
1. Are you entering codes for Lotto Sorcerer’s Apprentice? Lotto Sorcerer codes will not work with Lotto Sorcer-
er’s Apprentice (or vice versa). 
 
2. Are you entering the codes for your installation’s serial number? Your serial number is unique, and the registra-
tion codes are based on this serial number. 
 
3. Are you entering codes for your platform? Codes for the Windows version will not work with the Mac OS X 
version (and vice versa). 
 
4. Are you entering your name EXACTLY as we sent it to you? If we sent your name as “John R. Doe”, do not en-
ter “John R Doe”, “JOHN R. DOE”, “J. R. Doe”, “john r. doe”, “John Doe” or any other variation. 
 
5. Are you entering the registration code EXACTLY as we sent it to you? The registration code always starts with 
any capital letter; the remainder is either numbers from “0” to “9” or capital letters from “A” to “F”. 
 
6. Only standard Roman characters are used. Non-Roman characters are mapped to the nearest Roman character. 
For example, “Müller Brøderbund” will be mapped to “Muller Broderbund”. 
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If You Have Not Received Your Registration Codes… 
 
We send out the registration codes within 24 hours of the receipt of payment… although most codes are sent out 
within a couple of minutes. We have nothing to gain by withholding your registration codes, since a large part of 
our business is from satisfied customers who continually purchase upgrades. 
 
If you do not receive your codes after 24 hours, follow these guidelines: 

1 :  Check you r  s p am fo l d e r  
The word “Lotto” in our email seems to trigger a lot of false positives with spam filters (and especially with Google 
mail and Yahoo mail). So check your spam, or junk mail folder. It is always a smart practice to add 
“sales@satoripublishing.com” on your white list of trusted email senders. 

2 :  Ve r i f y  t h a t  you r  PayPa l  a d d r e s s  i s  you r  cu r r e n t  ema i l  a d d r e s s  
This is actually very common: people have registered with PayPal with an older email address. We send the codes 
to your PayPal address. Tip: PayPal will send you an email receipt within seconds of your purchase. If you have not 
received this email receipt from PayPal, this is probably the cause of the problem (because PayPal is also using 
your old email address).1 

3 :  Ve r i f y  t h a t  you r  ema i l  box  i s  no t  f u l l  
This too, is common. If your email box is full, incoming email will not be delivered. 

4 :  Con t a c t  u s  
Please contact us at support@satoripublishing.com. Include your phone number in the email! If you are having 
trouble receiving our emails, it is pointless sending you additional emails. We will contact you by phone. 
  

                     
1 This applies only if you purchased by PayPal. If you purchased by an alternative method, please ensure your email address is correct. 
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Appendix A: Using the System Clipboard 
 
Lotto Sorcerer’s Apprentice gives you the option to use the System Clipboard in many of its functions. The System 
Clipboard is built into the operating system, allowing you to send and receive data from different programs (or 
from within the same program). 
 
There are three functions to the System Clipboard: 

1. Cut: removes the source data, and send it to the Clipboard. 
2. Copy: copies the source data to the Clipboard. 
3. Paste: copies the source data from the Clipboard to the target. The source material data in the Clipboard. 

 
Only one item can be in the Clipboard at a time. Cutting or copying to the Clipboard will overwrite any existing 
data. 
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Appendix B: Web Scraping 
 
Web scraping is a unique feature of Lotto Sorcerer’s Apprentice that can help you enter past drawings into Lotto 
Sorcerer’s Apprentice. 
 
The process consists of: 

1. Copying the drawing data from the website by highlighting the text, and copying the text to the System 
Clipboard; 

2. Clicking the “Scrape” button in Lotto Sorcerer’s Apprentice. If successful, the drawing data will be inserted 
into the text boxes of the Main Window. 

Notes 
• This feature will work only with text data; it will not work with image data. 
• Some web browsers present data in scrapable text format better than others. We highly recommend Mozil-

la’s Firefox as an especially good web browser this. 
• The Web Scraping feature is very forgiving, and will consider any non-numeric data as a separator. 
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Appendix C: Differences Between the Evaluation Version and the 
Registered Version 
 
The Evaluation Version has four limitations: 

1. The Evaluation Version is limited to a Analysis Strength of only 10% of the drawing history. 
2. The Evaluation Version is limited to 12 uses. 

 
 
The Registered Version does not have these limitations. 
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Appendix D: Gamble Responsibly 
 

 
 
If you choose to gamble, we urge you to: 

• Gamble responsibly. 
• Play within your means. 
• Gamble with no more than your discretionary income. 
• Don’t “chase your losses”. 
• Set your play limit and stick to it. 

 

Symptoms of Gambling Addiction 
1. Regret over the amount of money or time spent on gambling. 
2. Spending more than you can afford on gambling. 
3. Spending money on gambling while financial responsibilities are neglected (neglect of paying bills, rent, 

etc.). 
4. Spending money on gambling while personal responsibilities are neglected (neglect of family, pets, chari-

ties, commitments, etc.). 
5. “Cutting back” on a necessity (food, medicine, etc.) in order to pay for gambling. 
6. Covering up or lying about the amount of money spent on gambling. 
7. Purchasing lottery tickets at multiple locations to allay suspicions of sales clerk that you may have a gam-

bling problem. 
8. Having a compulsion to purchase tickets regularly; to never miss a drawing of your favorite lottery. 
9. Breaking the law in order to get gambling money or recover gambling losses (stealing, fraud, etc.). 
10. Asking for financial assistance as a result of gambling. 
11. Continued gambling despite negative consequences: loss of job, relationships or opportunities. 
12. Denial of a gambling problem or lying to friends or family about behavior. 
13. Rationalizing one’s gambling, or believing that this list of Symptoms of Gambling Addiction does not apply 

to you. Remember, “rationalize” means “rational lies”. 
 
Gambling addiction is a continuum, from “at-risk gambler” to “problem gambler” to “compulsive gambler”. Match-
ing even one symptom, listed above, is a red flag. The more symptoms you match, the more addicted you may be.  
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